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Abstract

Platelets and their activation status play an essential role in cancer metastasis. Therefore, the anti-metastatic potential
of antiplatelet drugs has been investigated for many years. However, the initial screening of these antiplatelet drugs
to determine which agents can inhibit the interactions of platelets and tumor cells is very limited due to reliance upon
expensive, time-consuming, and low-throughput animal experiments for screening. In vitro models of the platelet -

tumor cell interaction can be a useful tool to rapidly screen multiple antiplatelet drugs and compare their ability to
disrupt platelet - tumor cell interactions, while also identifying optimal concentrations to move forward for in vivo
validation. Hence, we adopted methods used in platelet activation research to isolate and label platelets before mixing
them with tumor cells (MDA-MB-231-RFP cells) in vitro in a static co-culture model. Platelets were isolated from
other blood components by centrifugation, followed by fluorescent labeling using the dye CMFDA (CellTracker ™
Green). Labeling platelets allows microscopic observation of the introduced platelets with tumor cells grown in cell
culture dishes. These methods have facilitated the study of platelet - tumor cell interactions in tissue culture. Here,
we provide details of the methods we have used for platelet isolation from humans and mice and their staining for
further interaction with tumor cells by microscopy and plate reader - based quantification. Moreover, we show the
utility of this assay by demonstrating decreased platelet - tumor cell interactions in the presence of the T-Prostanoid
receptor (TPr) inhibitor ifetroban. The methods described here will aid in the rapid discovery of antiplatelet agents,
which have potential as anti-metastatic agents as well.

Key features

e Analysis of platelet-tumor cell binding dynamics.

e In vitro methods developed for measuring platelet-tumor cell binding to enable rapid testing of antiplatelet and
other compounds.

e Complementary analysis of platelet—tumor cell binding by imaging and fluorimetry-based readings.

e Representative results screening the effect of the antiplatelet drug, ifetroban, on platelet—tumor cell binding using
the protocol.

e Validation results were presented with both a TPr agonist and ifetroban (antagonist).
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Graphical overview
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Representative overview of the process to isolate and label platelets, incubate platelets and tumor cells in the
presence of antiplatelet agents, and image and/or quantify platelet—tumor cell interactions.

Background

Platelets are well known to play various crucial roles in hemostasis and thrombosis. However, growing evidence
suggests that platelets are significantly involved in cancer metastasis as well (Gay and Felding-Habermann, 2011).
Further, preclinical and clinical evidence has shown that platelets promote tumorigenesis and metastasis by paracrine
interactions with cancer cells (Labelle et al., 2011). Cancer cells change platelet behavior by directly inducing
tumor—platelet aggregates and triggering platelet activation (granule and extracellular vesicle release, altered
phenotype, etc.). Further, platelet activation has been directly or indirectly linked to the dissemination of cancer
cells, cancer cell survival within the circulation, and the extravasation of cancer cells at distant sites of metastasis
(Xu et al., 2018). Since platelet activation pathways are likely contributors to cancer growth and metastasis,
antiplatelet drugs have immense potential for the treatment of cancer metastasis by inhibiting a myriad of events
that drive cancer growth and metastasis (Gay and Felding-Habermann, 2011; Wojtukiewiczet al., 2017; Lucotti et
al., 2019; Tao et al., 2021). For instance, we recently discovered single nucleotide polymorphisms in TBXA2R, a
gene expressed on platelets, that correlate significantly with metastasis of many solid cancers, including breast,
melanoma, colon, and lung (Werfel et al., 2020). Further, we found that both hyperactivated and wild-type TPr
(Thomboxane A2-Prostanoid receptor)—the protein encoded by TBXA2R—contribute to cancer metastasis in
animal models. The safe and selective inhibitor of TPr, ifetroban, was able to reverse this effect and significantly
reduce metastasis of cancer cell lines in the same animal models. However, antiplatelet drug efficacy against
platelet—tumor cell interactions is challenging to study in vitro due to difficulties in fully replicating the dynamic
and intricate processes that occur in vivo and often requires screening directly in rodent models of metastasis. These
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rodent studies are expensive, time-consuming, and low-throughput, which is particularly burdensome when a large
number of antiplatelet drugs need to be screened. Hence, in order to rapidly screen for agents with anti-metastatic
potential through disrupting platelet—tumor cell interactions, we have developed methods for the fluorescent labeling
of platelets and the study of platelet—tumor cell interactions in vitro using Red Fluorescent Protein (RFP)-expressing
breast cancer cells (RFP-MDA-MB-231). Using these methods, we have carried out studies to quantify the
interaction of platelets and tumor cells in culture, alongside other reports also showing that platelets play key roles
in the survival and spreading of tumor cells early during the metastatic cascade (Ponert et al., 2018; Lucotti et al.,
2019).

Materials and reagents
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14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

24,
25.
26.

Bovine serum albumin (BSA) (Sigma-Aldrich, catalog number: A3059)

Coulter counter (Beckman; 50 uM aperture tube, 3—30 fl particles)

CellTracker™ Green CMFDA Dye (Thermo Scientific™, catalog number: C7025)

Dextrose (Sigma-Aldrich, catalog number: D9434-250)

DPBS (Ca%*/Mg?* free) (Gibco, catalog number: 14190359)

Dulbecco’s modified Eagle’s medium (DMEM) (Gibco, catalog number: 11965118)

EDTA (Sigma-Aldrich, catalog number: E5134)

Fetal bovine serum (FBS) (Gibco, catalog number: 26140079)

Calcium-free Hank’s Balanced Salt Solution (HBSS) (Sigma-Aldrich, catalog number: H9394)

. HEPES (Sigma-Aldrich, catalog number: H2034)
. Hydrochloric acid (Thermo Fisher Scientific™, catalog number: A466-2)

Ifetroban (Medchem express, catalog number: HY-105218)

. Mycoplasma-free MDA-MB-231-RFP cells (Gentarget Inc, catalog number: SC057-Bsd), and other tumor

cells/xenografts fluorescent protein—incorporated or later staining in the confocal step models can be tested in
a similar way

Paraformaldehyde 16% aqueous solution EM grade (Electron Microscopy Sciences, catalog number: 15710-S)
PBS, pH 7.4 (Thermo Fisher Scientific™, catalog number: 10010023)

Penicillin-streptomycin (P/S; 10,000 U/mL) (Gibco, catalog number: 15140122)

Potassium chloride (KCI) (Thermo Fisher Scientific™, catalog number: P217-500)

Prostaglandin E1 (PGE1) (Thermo Fisher Scientific™, catalog number: P5515)

Sodium citrate (Sigma-Aldrich, catalog number: C8532)

Sodium chloride (NaCl) (MP Biomedicals, catalog number: 194848)

Sodium hydrogen carbonate (NaHCO3) (Sigma-Aldrich, catalog number: S6297-250)

Sodium phosphate monobasic (NaH.PO4) (Sigma-Aldrich, catalog number: 71505-250)

TrypLE™ Express (Gibco, catalog number: 12604-021) or 0.05% Trypsin/EDTA (Gibco, catalog number:
15400-054)

U46619 (Cayman Chemicals, catalog number:16450)

Vectashield Antifade Mounting Medium with DAPI (Cole-Parmer®, catalog number: H-1200-10)

Triton-X 100 (Thermo Fisher Scientific™, catalog number: A16046)

Solutions
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Sodium citrate for anticoagulation of blood (see Recipes)
HBSS with EDTA (see Recipes)

DMEM complete media (see Recipes)

Washing buffer for platelets (see Recipes)

Resuspension buffer for platelets (see Recipes)

MTH buffer (see Recipes)
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Recipes

1.

Sodium citrate for anticoagulation of blood

a. Prepare a 3.8% solution of sodium citrate by dissolving 380 mg of sodium citrate in 7 mL of water (ddH,0).
Adjust pH to 7 with concentrated hydrochloric acid.

Add water to a final volume of 10 mL.

Store the solution at 2-8 <T for six months. Allow the solution to reach room temperature before use.

To anticoagulate blood with 0.38% sodium citrate final concentration, add 1 mL of 3.8% sodium citrate
solution to 9 mL of whole blood. Adjust the volume of sodium citrate according to the final blood volume.

®oo0oT

HBSS with EDTA

a. Add 250 pL of 1 M EDTA to 50 mL of HBSS and mix well.

b. Adjust pH to 6.4 with concentrated hydrochloric acid.

c. Store the solution at 2-8 <T for two weeks. Allow the solution to reach room temperature before use.

DMEM complete media

a. Remove the 50 mL of plain media from the fresh DMEM bottle in the cell culture hood.

b. Add 50 mL of heat-inactivated FBS to the DMEM bottle containing 450 mL of plain media.
c. Add 5 mL of Pen/Strep reagent (100> to the above mixture and mix it gently.

Washing buffer for platelets

a.  Add 0.1% wt/vol NaHCO; + 0.1% wt/vol BSA + 1 mM EDTA (Mw = 380.35 g/mol).

b. Add 10% MTH (Recipe 6) vol/vol in dH,0.

c. Prepare all of them in ultrapure distilled water.

d. Sterilize each buffer after preparation using a sterile filter unit inside the cell culture hood.

Resuspension buffer for platelets

a. Add 0.1% wt/vol NaHCO; + 0.1% wt/vol BSA.

b. Add 10% MTH vol/vol in dH,0.

c. Prepare all of them in ultrapure distilled water.

d. Sterilize each buffer after preparation using a sterile filter unit inside the cell culture hood.

MTH buffer

a. Add 134 mM NaCl (Mw = 58.44) + 0.3 mM NaH,PO42H,O (Mw = 156.01).

b. 3mMKCl(Mw = 74.55) + 5 mM HEPES (Mw = 238.3) + 5 mM dextrose (Mw = 180.16) + 2 mM MgCl,
(Mw = 203.3)

c. Prepare all of them in ultrapure distilled water.

d. Sterilize each buffer after preparation using a sterile filter unit inside the cell culture hood.

Laboratory supplies

CoNog RN PR

Pipette tips (Gilson, catalog numbers: F167104, F167103, F167101)

Pipettes (Eppendorf, catalog numbers: 3123000012, 3123000020, 3125000109, 3123000055, 3123000063)
1 mL syringe (BD, catalog number: 309628)

10 mL syringe (BD, catalog number: 305959)

50 mL syringe (BD, catalog number: 300865)

0.22 um syringe filter (Millex®, catalog number: SLGP033RS)

21 G syringe needle (Sarstedt, catalog number: 85.1162)

23 G syringe needle (BD, catalog number: 300800)

27 G syringe needle (BD, catalog number: 302200)

10 1.5 mL microcentrifuge tubes (Thermo Scientific™, catalog number: 69715)
11. 2 mL microcentrifuge tubes (Thermo Scientific™, catalog number: 69720)
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12. 15 mL centrifuge tubes (Thermo Scientific™, catalog number: 339650)

13. Black 96-well plate (Thermo Scientific™, catalog number: 229411)

14. 100 mm cell culture dishes (Thermo Scientific™, catalog number: 150464)

15. 48-well cell culture plate (Thermo Scientific™, catalog number: 8715064)

16. Collagen-coated 35 mm dish coverslip (MatTek Corporation, catalog number: NC9125998)

17. Cell counting chamber slides (Thermo Scientific™, catalog number: C10314)

18. Transwell® inserts (Corning, catalog number: 3401)

19. Round-bottom 10 mL Plastic centrifuge tube (Thermo Fisher Scientific™, catalog number: 02-689-6, BD
Vacutainer™ supplier)

20. EDTA/heparin-coated or Microhematocrit capillary tube (Thermo Fisher Scientific™, catalog number: 22-

362566)
Equipment
1. -20 < and -80 T freezers
2. Centrifuge with swing-out rotor suitable for 15 mL centrifugation tubes (Eppendorf, model: 5810R)
3. Liquid nitrogen dewar (Thermo Fisher Scientific™, catalog number: CY509113)
4. 37 <Tincubator (Thermo Fisher Scientific™, catalog number: FSGPD20)
5. Mouse restrainer (Braintree Scientific, model: SHORTI STD)
6. Analytical weighing scale (Mettler Toledo, ME104E and ME204E)
7. Laminar flow cabinet (Thermo Scientific™ 1300 Series Class Il, catalog number: 1323TS)
8. CO; cell culture incubator (Thermo Fisher Scientific™, HERAcell VIOS 160i, catalog number: 51030403)
9. Benchtop centrifuge (Eppendorf, model: 5810R)
10. Improved Neubauer cell counting chamber (EMS, catalog number: 68052-16)
11. LSETM low-speed orbital shaker (Corning™, catalog number: 6780FP)
12. Countess Il automated cell counter (Invitrogen, Thermo Fisher Scientific™, catalog number: AMQAX1000)
13. Brightfield microscope (Thermo Fisher Scientific™, catalog number: LMI6PH1)
14. Microhematocrit capillary tubes (Thermo Fisher Scientific™, catalog number: 22-362574)
15. Microplate reader (BioTek, model: Synergy H1). Fluorescence intensity details: Top, fluorescein 2.5 pM (0.25

fmol/well 384-well plate); bottom, fluorescein 4 pM (0.4 fmol/well 384-well plate); bandpass = 18 nm
(excitation and emission), fluorescein 0.25 pM (0.025 fmol/well 384-well plate); light source: Xenon flash
lamp, wavelength range: 230-999 nm, 1 nm increment, bandpass: 4 nm (230-285 nm), 8 nm (> 285 nm) and
wavelength range: monochromators: 250700 nm, detection system: PMT detectors

16. Confocal microscope (LEICA SP8X, Wetzlar, Germany):
Objectives: HC PL APO CS2 40>/1.10 water
Lasers: 405 Diode (on), 442 diode, WLL (on, 70.00%)
Channels: Green, Gray, Blue, and Red
Laser lines (nm): 405, 442, 491, 554, 472, 491, 667, 670
Optimal settings: Scan mode (xyz), Scan speed (400 Hz), Magnification (40), Immersion (water), Pinhole (77.2
um) and Emission wavelength (580 nm)

Software

Genb5, 3.05 (BioTek Instrument)

Prism, 9.2.0 (GraphPad)

Confocal microscopy image analysis software (Leica application suite 3.7.6)
Photoshop 21.1 (Adobe)

ImageJ 13.0.6 (imagej.nih.gov/ij/download/)
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Procedure

Perform all protocol steps for live platelets at room temperature. Do not put platelets on ice. A Schematic overview
of the experimental process is shown in the Graphical overview.

A. Collection of human blood

1. Draw 5 mL of venous blood into a 10 mL syringe with a 21 G syringe needle from a consenting adult
donor. This should be performed by a competent phlebotomist.

2.  Remove the needle from the syringe and immediately and gently transfer blood into a round-bottom 10
mL centrifuge tube containing 1 mL of 3.2% sodium citrate (see Recipes).

3. Mix blood with sodium citrate by gently inverting the tube three times.

B. Collection of mouse blood

1. Collect 75 uL of blood from the mouse dorsal pedal vein or another venous non-terminal collection site.
For blood collection from the pedal vein, place the mouse into a restrainer and puncture the vein with a 23
G and 27 G syringe needle.

2. Collect the blood by holding an EDTA/heparin-coated capillary tube to the puncture site. Pre-warming the
mice using a heated gel pack greatly aids the identification of the pedal vein.

3. Alternatively, collect 900 uL of blood by cardiac puncture under terminal anesthesia with a 23 G needle
and 1 mL syringe. Remove the needle from the syringe and transfer blood immediately to a 2 mL
microcentrifuge tube containing 100 uL of 3.2% sodium citrate.

C. Production of platelet-rich plasma (PRP) from whole blood

1. Centrifuge whole blood at 350>g for 20 min at room temperature (RT) or 1,300%g for 10 min at 22 <C.
2. The blood will have separated into two layers: the lower, dark layer of packed red blood cells and the
upper yellow layer of PRP. The PRP volume will be approximately 50% of the whole blood volume.

3. Carefully remove the upper PRP layer and transfer it to a new round-bottom centrifuge tube.
4. PRP may be used directly in cytometry experiments. Further processing is required to generate washed
platelet suspensions.

D. Platelet separation and washing

1. Wash platelets by diluting PRP (see Procedure C) with 5 volumes of the HBSS, supplemented with 4 mM
EDTA, pH 6.4, or washing buffer (see Recipes).

2. Centrifuge at 350xg for 20 min at RT or 1,300>g for 10 min at 22 <C.

3. Wash the platelet pellet gently without resuspending it three times with HBSS (supplemented with 4 mM
EDTA, pH 6.4) or wash buffer containing 0.25 uM PGEI1.

4. Washed platelets can be resuspended directly into DMEM complete media (see Recipes) or resuspension
buffer (see Recipes) suitable for the experiment.

5. Count platelets using a coulter counter.

6. Stain the washed platelets (8 > 10° cells/mL) with CellTracker™ Green dye (see section E3 below) and
readjust the required concentration in resuspension buffer or directly into DMEM complete media (see
Recipes).
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E. Examination of platelets and tumor cell interactions by confocal microscopy

1. Cell revival and maintenance

a.

g.

Recover MDA-MB-231-RFP or other tumor cells from liquid nitrogen and dip the lower half of the
vial into the 37 °C water bath or bead bath to thaw.

Do not let the whole content of the vial completely thaw (a small piece of ice should be visible inside
the vial), wipe the vial from outside with 70% ethanol, and move to a laminar flow cell culture hood.
Open the vial and add contents into a 15 mL centrifuge tube containing pre-warmed complete media.
Centrifuge the 15 mL centrifuge tube containing cell and DMEM complete media (see Recipes) at
250% g for 5 min at RT.

After centrifugation, wipe the outside of the 15 mL centrifugation tube with 70% ethanol, move to a
laminar flow cell culture hood, and decant the media in the liquid discarder without disturbing the cell
pellet.

Pipette out the 1 mL fresh DMEM complete media (see Recipes) in the 15 mL centrifuge tube
containing the cell pellet and resuspend the cells by slowly inverting the tube. Disperse the cells in a
100 mm dish plate containing 10 mL OF DMEM complete media (see Recipes) and keep the cultured
dish plate in a 37 °C, 5% CO, humidified cell culture incubator.

Replace the media with fresh DMEM complete media every 2—3 days.

2. Seeding cells into collagen-coated 35 mm dish cover glass

a.
b.
c.

Once the cells reach 80%-90% confluency, remove the media from a 100 mm dish by aspiration.
Wash cells with 2-4 mL of DPBS (Ca?"/Mg?" free) and remove the solution by aspiration.

Pipette 2—4 mL of pre-warmed 0.05% Trypsin solution into the 100 mm dish and incubate the dish in
a 37 °C, 5% CO, humidified cell culture incubator for 5 min.

Swirl the dish to ensure the solution covers all cells.

Observe the trypsinization process under the microscope at RT.

Once cells are suspended, pipette 6 mL of DMEM complete media to the flask to inhibit trypsin
activity.

Transfer the cell suspension into a 15 mL centrifuge tube and centrifuge at 250% g for 5 min to pellet
the cells.

Aspirate the media from the tube without disturbing the cell pellet.

Resuspend the cells in 1 mL of complete medium by gently pipetting the cells up and down and count
the cells using a cell counting chamber.

Seed cells (4 x 10* cells/dish) immediately into the 35 mm collagen-treated cover glass plates or 48-
well glass bottom plates (clear-culture plates) at a density of 3.5 x 10* cells/well in 500 pL of DMEM
complete media (see Recipes).

Following the addition of cells, switl the media in the dish to distribute the cells and place the 35 mm
collagen-treated cover glass and 48-well glass bottom plates in a 37 °C, 5% CO, humidified cell
culture incubator.

3. Platelet staining

a.

@ ~oape

h.

Fluorescently label the isolated platelets using CellTracker™ Green according to the manufacturer’s
protocol with slight modifications. Platelets isolated at a concentration of 8 x 10° cells/mL were
reconstituted in resuspension buffer.

Prepare the CellTracker™ Green stock solution (1 mM) by adding the 20 uL of DMSO to a vial
containing 50 ug of CellTracker™ Green.

Prepare the working CellTracker™ Green solution to 2 uM by diluting it in 1x PBS.

Add 200 pL of working CellTracker™ Green solution (2 uM) to 1 mL of platelet suspension.
Immediately mix the sample by gentle pipetting and incubate the sample for 10 min at 37 °C.

After incubation, centrifuge the sample at 350x g for 20 min at RT.

Discard the supernatant and wash the pellet with warm PBS or washing buffer thrice by resuspending
the pellet in PBS/washing buffer before centrifugation during each wash and after centrifugation. PBS
should be discarded without disturbing the pellet.

Resuspend the platelets pellet (6 x 104100 uL) in the resuspension buffer for treatment.
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4. Treatment with agonist and antagonist
a. Afterthe labeling, activate the platelets by incubation with an agonist (U46619, 0.3 uM in PBS) and/or
antagonist (Ifetroban, 10 uM in PBS) (Table 1).

Table 1. Examples of platelet agonists or antagonists and concentrations for platelet activation

Platelet agonist or Concentration Incubation temperature  Incubation time
antagonist

U46619 03 uM 37°C 15 min

ADP 10 uM 37°C 1 min

Thrombin 1 U/mL 37°C 1 min

Collagen 5 pg/mL 37°C 15 min
Ifetroban 10 uM 37°C 15 min

Incubate platelets for 15 min at 37 °C.
After incubation, centrifuge the sample at 350x g for 20 min at RT.

d. Discard the supernatant and wash the pellet with warm PBS or washing buffer thrice by resuspending
the pellet in PBS/washing buffer before centrifugation during each wash and after centrifugation. PBS
should be discarded without disturbing the pellet.

e. Resuspend the platelets pellet (6 x 104100 pL) in the resuspension buffer or cell culture media
(DMEM complete media, see Recipe) for treatment.

5. Treatment and confocal examination

a. Observe cell growth in 35 mm collagen-treated cover glass (see step E2k). If the cells are confluent
(80%-90%), then add the agonist- or antagonist-treated CellTracker™ Green-labeled platelets (6 x
10%in 100 pL of DMEM complete media or PBS) (see step E4e).

Incubate the cultures in a 37 °C, 5% CO; humidified cell culture incubator for another 30 min.

c. Wash the cells thrice with warm PBS to remove unbound platelets.

d. Fix the cells with 2% paraformaldehyde (diluted from 16% paraformaldehyde) in PBS for 15 min in
a dark room.

Gently wash the cells twice with warm PBS.

f.  Add 0.5 mL of mounting media with DAPI to fix cells and either examine immediately under confocal

microscopy or store the slides at 4 °C until further analysis.
6. Platelet quantification by microplate reader analysis

a. Repeat steps ESa—ES5c.

b. Lyse platelets bound to tumor cells (see step E5c) with 200 puL of Triton X-100 (10% in PBS) agitated
for 5 min.

c. Transfer cell lysates to black 96-well plates and measure the fluorescence at excitation and emission
wavelengths of 485 and 525 nm, respectively, using a microplate reader. Use at least triplicate samples
to quantify platelet levels.

Data analysis
A. Confocal imaging

1. Forthe confocal imaging, at least three independent experiments, each of which originated from a different
treatment, should be performed, and multiple images should be captured for each experiment.

2. Capture the images of all corners and center of the culture dishes. Captured images are analyzed with
Image] software to measure the average fluorescence pixel intensities of green fluorescence in the various
treatments (such as in Figure 1A, 1B, 1C, and 1D) (Wu et al., 2013) and processed with the Photoshop
software [these will be the analytical regions of interest (ROIs)].
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Platelets+cells Platelets+cells+U46619  Platelets+cells+Ifetroban Platelets+cells+Ifetroban
+U46619

Figure 1. Representative pictures of CellTracker™ Green-labeled platelets interacting with MDA.-
MB-231-RFP cells stained with DAPI. CMFDA-labeled platelets (green color), MDA-MB-231 RFP
cells (red color), and DAPI (blue color). Representative confocal images control (platelet + tumor cells)
(A), thromboxane A. receptor agonist, U46619-treated platelet + tumor cells (B), platelet antagonist,
Ifetroban-treated platelet + tumor cells (C), and co-treatment of Ifetroban- and U46619-treated platelet +
tumor cells (D). Objectives: HC PL APO CS2 40>/1.10 water, scale bar is 15 um, and the zoom of ROI
5% ImageJ software is used to measure the average fluorescence intensities per pixel in all the treatments.

Fiji (Fiji is just ImageJ) can be downloaded at https:/fiji.sc/. Export the raw image data in a format
compatible with ImagelJ (e.g., tif) from the imaging system and import into ImagelJ.

Go to Analyze > Set Measurements and check off the box next to Limit to Threshold. Then use Image >
Adjust > Threshold to highlight the area you want to analyze, and then Analyze > Measure will give you
intensity measurements in just your thresholded area.

Alternatively, draw a ROI in an area of the image around your object with one of the drawing tools (in the
toolbar) and then Analyze > Measure will limit its measurement to that area. Do the same to another image
to analyze the same size/shape area.

Export the green fluorescence pixel intensities data to Microsoft Excel. Calculate the mean and standard
deviations (n = 3) of data from at least three independent experiments.

Present the data in mean + SD (n = 3) and analyze the data by one-way ANOVA followed by Tukey’s test
using Prism (GraphPad).

Changes in the treatment can be represented with respect to the percentage of control (normalization),
where bars with different letters indicate significant (p < 0.05) differences between the groups (Toragall et
al., 2023).

The represented confocal image results should be confirmed by examining three independent experiments.

Plate reader fluorometric assay

4.

For the fluorometry assay, collect the green fluorescence reading data (n = 3) from at least three
independent experiments, each of which originated from a different treatment from the plate reader.
Calculate the mean and standard deviations (n = 3) using Microsoft Excel from the above recorded data.
Present the data in mean = SD (n = 3) and analyze the data by one-way ANOVA followed by Tukey’s test
using Prism (GraphPad).

Changes in the treatment can be represented with respect to the percentage of control (Figure 2) and
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represent bars with different letters indicating significant (p < 0.05) differences between the group
(Toragall et al., 2023) (Materials and reagents section).
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Figure 2. Representative quantification of platelet (CellTracker™ Green—labeled) and tumor cell
(MDA-MB-231-RFP) interactions using a microplate reader. Data are expressed as mean £SD (n = 3)
and analyzed by one-way ANOVA followed by Tukey’s test; bars with different letters indicate significant
(p < 0.05) differences between the groups. Changes in the treatment are represented with respect to the
percentage of control.

Validation of protocol

The protocol presented here was validated using confocal microscopy to image platelet—tumor cell binding and
fluorimetry on a plate reader to measure the overall fluorescence of platelets in platelet—tumor co-culture. Moreover,
the utility of these assays to determine changes in platelet—tumor cell binding in the presence of platelet agonists
and antagonists was assessed using the TPr agonist U46619 and TPr antagonist Ifetroban. Figure 1 shows confocal
microscopy images of RFP-expressing MDA-MB-231 tumor cells in co-culture with platelets that were pre-labeled
with CellTracker™ Green. These images show that platelets have low, but observable, levels of binding to tumor
cells under resting conditions (Figure 1A). As expected, platelet binding to tumor cells increases drastically when
the TPr agonist U46619 is added to the media (Figure 1B). Since platelet—tumor cell binding was fairly low under
basal conditions, the treatment of platelets with TPr antagonist ifetroban had little effect on platelet—tumor cell
interactions (Figure 1C). However, pre-treatment of platelets with ifetroban prior to the addition of U46619
completely abrogated the effect of U46619 on platelet—tumor cell binding (Figure 1D), suggesting that ifetroban is
effective at limiting TPr-mediated platelet—tumor cell interactions. Next, fluorimetry readings on a microplate reader
were used to confirm the imaging results. Again, there was a significant increase in platelet—tumor cell binding in
U46619-treated co-cultures (Figure 2), as indicated by increased platelet fluorescence after washing, whereas the
fluorescence in co-cultures with ifetroban-pre-treated platelets returned back to control levels. Importantly, the
trends observed by plate reader—based fluorimetry matched the relative trends between groups obtained when
quantifying confocal images as well (Figure 3). Taken together, these results validate that isolated platelets and
tumor cells can be co-cultured, imaged via high-resolution confocal microscopy, quantified for total fluorescence
using a microplate reader, and used to rapidly screen the effectiveness of antiplatelet drugs such as ifetroban.
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Figure 3. Representative quantification of platelet (CellTracker™ Green-labeled) and tumor cell (MDA-MB-
231-RFP) interactions using confocal images by ImageJ analysis of fluorescence intensities. Data are expressed
as mean £SD (n = 3) and analyzed by one-way ANOVA followed by Tukey’s test. Bars with different letters
indicate significant (p < 0.05) differences between the groups. Changes in the treatment are represented with respect

to the percentage of control.

General notes and troubleshooting

General notes

There are stopping points at this blood collection steps (sections A and B). The collected blood must be
processed immediately for the PRP production. However, once the PRP is separated, it can be stored at room
temperature for another 5 days for further experiments.

After the centrifugation, the platelets have pelleted down and supernatants (platelet poor plasma; PPP) are
separated and must be recentrifuged to ensure the platelet yield/losses by handling errors (pipetting) (section
B)

Ideally, the ratio of blood to sodium citrate (1:10) works well; this is what we have used in the present protocol.
However, the ratio may vary with rodent models and geographical location of animals. Hence, we suggest
optimizing different citrate ratios before proceeding with actual experiments (section B).

Human blood platelets have been used to label and treat tumor cells throughout the study. However, the steps
can be used for mice blood platelets as well. For additional experiments with flow cytometry, 10 pL of PRP
(step C3) can be used to verify the platelet activation markers (Burzynski et al., 2019) (section C).

A low level of leukocytes will be present in washed platelets. Repeated rounds of the washing protocol will
reduce leukocyte load, but it does not significantly reduce the platelet count (section D).

We have used the resuspension buffer (500 uL, which should be no more than 25% of total complete media in
the culture dish) for redissolving the platelet pellet to get a uniform distribution of platelets (homogenous
mixture). However, one can use the complete media to dissolve it (there is no volume restriction) (section D).

For the confocal studies, seed the tumor cells in the center of the 35 mm collagen-treated cover glass plates for
better examination of tumor cell and platelet interactions. Further, the 96-well clear-bottom plates can be used
for the lysate assay with MDA-MB-231 RFP cell seeding density of 8.5 x 10° cells per well in 200 pL of
complete media (section E2).

To avoid the platelet clustering on coverslips, avoid using coverslips that are less than 95% confluent with
tumor cells for the confocal microscopy studies, keep an extra control of coverslip treated with only labeled
platelets, and image under confocal microscopy (section E2).

While labeling the platelets with fluorescent dyes, make sure to count the platelets (coulter counter) before and
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after labeling and optimize the different concentration fluorescent dyes to the number of platelets using the
plate reader (excitation and emission wavelengths of 485 and 525 nm). Consider the highest number of platelets
with higher fluorescence reading for better platelet labeling (section E3).

10. Platelets are sensitive and should be handled gently to avoid activation. Platelet-rich plasma and washed
platelets should be kept at room temperature.

11. Sodium citrate is the recommended anticoagulant for these protocols, as its chelation of divalent cations is
reversible with the addition of CaCl,, allowing for the easy production of serum. These protocols can also be
performed using other non-reversible anticoagulants, if necessary (Burzynski et al., 2019).

12. Repeated washes/centrifugation in case of HBSS (supplemented with 4 mM EDTA, pH 6.4) may lead to
activation of platelets; this is reported from the previous publication by Burzynski et al. (2019). However, the
use of the PGE-1 with washing buffer can be incorporated to limit activation of platelets during wash steps
(Lucotti et al., 2019). Further, the PGE1-containing buffer should only be used after the first wash (section D).

13. The detection of small fluorescently labeled particles by confocal microscopy (platelets) depends on the
respective area of focus. The dish or slide must be scanned thoroughly for many representative portions and
the confocal images can be analyzed using ImageJ software for the quantification of bound platelets around the
tumor cells. The software is suitable to detect the platelet population and can be used to calculate the percentage
of tumor cells covered with platelets.

14. Foradditional information related to confocal image processing for fluorescent intensity using ImageJ software,
please visit the website below.
https://www.unige.ch/medecine/bioimaging/files/1914/1208/6000/Quantification.pdf
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